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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site. You can store your issues of 
MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from Mavericks) to have it appear on your iPhone and iPad (inside iBooks) 
next time you sync. Or print it out, even – and please feel free to pass MagBytes on. 
MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by Mac NZ for this purpose 
only. Find out more about the MagBytes Apple newsletter online (click on Mac NZ MagBytes Newsletter at top centre).

January 2016  
•2——Mac News ~ Cook & 

Pope, Car, Maps, Shares, iFans, 
Trump, Passwords, Phish, 
Diversity, Air turns 8, Tax, 

Satisfaction. 
•4——Updates ~ Logic, iMovie, 

OS X & Microsoft Office 
 •5——Mac Help ~ Around New 

Zealand 
•6—— iOS & iDevice news ~ 

4-inch iPhone, Microsoft failure, 
(RED), Networks, Passcodes, 

Music Memos, ViewPop 
•8——Tips & Tricks ~ Mac tips 

easy to complex, 10 iPhone/
iPad holiday tips; Mac secrets 

revealed. 
•12——Clean & Tidy ~ Keep 
on top of  your iDevice & Mac 

with some housekeeping 
•14——Shiny & New ~ Optical 

glasses combat tiredness

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

It’s been so hot in Auckland, 
even my iPhone has been sweating. 

mailto:mac.nz%40me.com?subject=From%20MagBytes
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http://www.mac-nz.com
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Mac News Cook & Pope ~ car probs ~ Maps ~ shares back up ~ iFans in China

Apple CEO met the Pope
A peek at the schedule of Pope Francis has revealed 
the head of the Catholic Church met with Apple Chief 
Executive Tim Cook on Friday, though what the two 
discussed has not been disclosed.

Apple’s ‘Project Titan’ chief  to leave 
Apple veteran Steve Zadesky, thought to be heading up 
the company’s Project Titan automotive initiative, has 
informed colleagues he plans to leave the company, 
according to a report published Friday.

Apple expands Maps capabilities
Apple’s efforts to improve its in-house Maps service 
moved forward last Thursday with the addition of 
four new Flyover locales (Japan; Bruges, Belgium; 
Lake Powell, Utah; and Limoges, France – now Flyover 
is available in 220 locales around the world), public 
transit data for Los Angeles, a European expansion of 
Nearby POI suggestions and Traffic data for Hong Kong 
and Mexico.

Apple shares above US$100 again
Apple shares closed above US$100 on Friday. The stock 
closed at US$101.43, up more than 5.1% in trading 
for the day from its previous close of US$96.30. In 
anticipation of a good to great financial report from 
the company, perhaps?

The world of  Apple ‘iFans’ in China
Freelance writer Mitchell Blatt has taken a peek inside 

61 Hurstmere Road, Takapuna 09 486 1493

Authorised to service iPod, 
iPad and Mac

www.istorenz.com

Enhancing Your Apple Experience

Scan QR Code to quickly 
get in touch with iStore
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Mac News Trump ~ passwords ~ phish ~ diversity ~ Air 8 ~ tax bill ~ satisfaction

the world of Apple superfans and ‘iFans’ in 
China. Based in part on a store opening in 
Nanjing, Blatt wrote about the culture of 
Apple Store openings in that country, and 
the kinds of people who gather from all 
over the country to attend them, including 
some folks who got in line just because 
they, “have a feeling of togetherness 
waiting in line.”

Trump’s plans for Apple
Republican presidential hopeful Donald 
Trump unveiled a new plan should he 
win the election: make Apple to move all 
product manufacturing into the United 
States. Trump shared his ‘idea’ during a 
Martin Luther King Junior Day speech at 
Liberty University on Monday. So much 
for the capitalist spirit. [And hello, price 
rises …]

Death, passwords: make a plan
When we die whatever is tucked away 
in our brains goes with us, including 
passwords for our online accounts. One 
woman learned that the hard way after 
her husband passed away and she tried 
to get the password from Apple for his 
Apple ID. The big lesson here: plan ahead 
so there’s a way for trusted people to get 
at your important passwords when you’re 
gone.

Phishing scam looks like Apple
Bryan Chaffin received “the best looking 
phishing email I’ve seen in a long time, 
if not ever, and wanted to make folks 
aware of it. While it looks like it could be 
from Apple, including legitimate links to 
Apple’s Support site and online forums, 
the link to ‘My Apple ID’ is to http://
nuestrocafe.es/ar, not an Apple URL, and I 
don’t recommend loading it in a browser.” 
[Always check the From email address!]

Slow progress to diversity
Apple’s 2015 EEO-1 report shows slow 
progress toward workplace diversity. 
Apple has quietly released its latest EEO-1 
Federal Employer Information Report 
tallying employment diversity information 
through Aug. 1, 2015, revealing raw 
numbers that, while a slight improvement 
year over year, are incongruent with 
statements the company made last year. 
And Apple’s board toned down diversity 
efforts too. Meanwhile, Apple honoured 
Martin Luther King Junior Day ...

MacBook Air is 8
Apple used to announce a lot of new 
products in January, around the time of 
Macworld Expo. One was the introduction 
the MacBook Air, which Apple introduced 
on January 15, 2008 (it wasn’t available in 

stores until January 
29 of that year).

Apple could 
owe big taxes 
As a result of 
a European 
Commission 
investigation into 
its tax policies, 
according to 
an analysis by 
Bloomberg 
Intelligence, Apple 
could owe more 
than $8 billion US 
in back taxes. [Plus 
what the years of 
investigation have 
cost?]

70% 
satisfaction 
According to the 
“Product and 
Relationship 
Satisfaction of IT 
Clients, 2016” from 
the Temkin Group, 
Apple has a 70% 
satisfaction rating.
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Apple rolls out Logic Pro X 10.2.1 
Apple has updated Logic Pro X, its Mac OS X software for 
professional songwriting, editing, and mixing, to version 
10.2.1. According to Apple, the upgrade contains bug fixes and 
enhancements including:
• New multi-threading feature improves performance when 
processing multiple live channels;
• Faster playback responsiveness when previewing Apple Loops 
and performing region edits;
• Flex Pitch editing can be performed within the Tracks area using 
a Piano Roll interface;
• 30 plug-ins have been redesigned to add Retina support and 
improve usability;
• Numerous improvements to Alchemy 
including Apple Loops support and 11 new 
spectral effects
•Improved reliability when downloading 
additional content;
•Additional content can be downloaded directly from the Sound 
Library and Apple Loops browsers;
•Drum Machine Designer supports drag and drop of multiple 
audio files;
•The Step Editor can automatically create lanes to display all MIDI 
events in a region;
•New export option allows you to create stems from multiple 
selected tracks
•Improved VoiceOver support.
The update for current Logic Pro X users is free and available now 
through the Mac App Store. For new users the software costs 
US$199.99 (about NZ$300). It requires Mac OS X 10.9 or later.
(Apple has profiled Adele producer Greg Kurstin to promote 
Logic Pro X.)

Apple releases OS X 10.11.3
Apple has released Mac OS X 10.11.3 and iOS 9.2.1. The latest 
version of OS X El Capitan provides bug fixes and security updates  
– obtain it via the Updates section of the Mac App Store.

iMovie for Mac version 10.1.1 
 iMovie for Mac has been upgraded to version 10.1.1. It’s available 
via the Updates tab in the Mac App Store. According to Apple, the 
update resolves an issue with YouTube sharing that could prevent 
sign-ins for users with multiple accounts; fixes a problem that 
could prevent white balance adjustments from being applied to 
clips; correctly plays Sony XAVC S clips captured at 100 or 120 

frames per second; resolves an issue 
that could lead to the incorrect display 
of images.
Also, clips are now copied when 
dragged from the Project Media 
container to events in the Library list. 

iMovie 10.1.1 also received stability improvements.

Feature-packed public beta of  OS X 10.11.4
OS X 10.11.4 public beta with Live Photos support are now 
available to public testers. If you want to test-drive these pre-
releases, you can join the Apple Beta Software Program. Being a 
part of the public beta program will give you access to pre-release 
versions of both of Apple’s platforms, iOS and OS X. Here’s how 
to go back to the shipping version of the software if you want to 
un-enroll from the Apple Beta Software Program.

Office 2016 for Mac updates
Microsoft has updated Office 2016 for Mac, adding not just 
bugfixes but new features for all of the apps in the suite.

Updates Logic Pro 10.2.1 ~ OS 11.3 ~ iMovie ~ 10.11.4 ~ Microsoft Office 2016

mailto:mac.nz%40me.com?subject=From%20MagBytes
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Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Plus there’s Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. 
Every new Mac has a one-year warranty 
and 90 days free phone support. 
AppleCare extends this all out to three 
years. Under NZ law, you are covered by 
the Consumer Guarantees Act against 
anything going wrong that comes 
down to parts failure within reasonable 
expectations (say, inside three years’ use), 
but be prepared to spend anxious time on 
the phone, sticking to your guns to get it 
fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 

If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.

Eden Roskill — This Auckland branch has 
an Apple interest group. 

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 

Mac & iDevice training in Grey 
Lynn, Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ – but I also run the Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. A new 
series is starting Wednesday March 4th at 
7:30pm. Please email if you are interested 
in attending, as I only book a room when I 
can guarantee five attendees. The sessions 
are friendly, open to questions at all times 
and are backed up by handouts, and one 
is running now on Wednesday nights 
(7:30pm). I train (one-to-one at your home 
or workplace (in Auckland) for $95/hour. I 
also present to institutions.
Please email Mark for more info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help Apple assistance, Consumer Guarantees Act, help, support

rest homes. This is a large, well-run and 
successful group.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news
Rumoured 4-inch iPhone
A picture of a device said to be Apple’s 
latest rendition of an iPhone with 
a 4-inch display hit the internet on 
the weekend, this time placed next 
to an iPhone 5 for comparison. The 
device in the photo bears an identical 
design to the iPhone 6 series, just in 
a shrunken form factor that barely 
eclipses the iPhone 5 in size. The shot 
was shared by a user at Dutch tech 
site OneMoreThing.nl.

Patriots fans blame Microsoft
Fans of the New England Patriots who 
are searching for a reason for the loss 
to Peyton Manning and the Denver 
Broncos in the AFC Championship 
might want to take part of their 
anger out on Microsoft. During the 
second quarter, the Microsoft Surface 
Pro tablets that all NFL teams are 
forced to use as part of a Microsoft 
marketing deal stopped working for 
the Patriots so coaches couldn’t show 
players some pictures.

Apple renews with (RED) 
With UNAIDS data showing that 
mother-to-child transmission of HIV 
could be effectively ended as early 
as 2020, Apple, América Móvil, Bank 

4-inch ~ fans blame Microsoft ~ Apple renews with (RED)
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iDevice newsNetwork problems ~ Passcode ~ Music Memos ~ ViewPop

of America, Belvedere, GAP, SAP, Starbucks and The Coca-Cola 
Company have renewed their partnerships with (RED) in support 
of reaching this goal, with NetJets, Salesforce and Tradeshift also 
announcing new partnerships with (RED) — the AIDS organization 
founded by Bono and Bobby Shriver — to fight AIDS.

iOS: Solving Network Connectivity Problems
So your iPhone won’t stay on a Wi-Fi network, or you can’t get it 
to join in the first place. What to do? Melissa Holt tells you.

Switch to 6 digits for your iOS passcode
A court case in the US makes it clear the government can at least 
try to brute-force your iPhone’s four-digit passcode. You can 
upgrade from four digits to six by following these steps…

Apple introduces Music Memos
Apple unveiled a surprise addition to its iOS lineup with a new 

Music Memos app, designed specifically to help musicians and 
songwriters craft new musical ideas on the go. Crafted after the 
existing Voice Memos app, it adds features to improve musicians’ 
workflow. The iPhone’s built-in microphone can be used to record 
instruments in a lossless format, and the resulting recordings can 
be analysed for rhythm and chords. The app can then add instant 
drums and a bass line to help flesh out the song, and it will also 
provide a basic notation view. Music Memos are synchronized via 
iCloud and can be opened directly in GarageBand or Logic Pro X. It 
should appear eventually, of dive in and get it (free) from the App 
Store now. 

NZ app ViewPop shoots 3D pictures on iPhones
ViewPop is a social network that lets you capture and share three-
dimensional photos from your phone. It has been developed 
by the two Kiwi brothers of The Prattley Company. You install 
the free app, create an account by putting in a username and 
password, activate via an email you receive (or create a Facebook 
login) and you’re good to go. You need your friends to join too, 
otherwise you can’t swap and view files.

Apple promises fix for iPhone 6s battery data
In a new support document, Apple has acknowledged a problem 
in which an iPhone 6s or 6s Plus may not show the right battery 
percentage as power drains. Apple is “investigating the cause and 
a solution,” but in the meantime there’s a workaround.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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tips&tricks
1/ Adjust your Mac display’s resolution 
settings — Macs ship with the display set 
at a certain resolution, and Apple defines 
this in the technical specifications for each 
model. But with Retina displays, these 
numbers can get confusing: there is the 
display’s resolution and the “looks like” 
resolution used on the Mac. Resolutions 
on Retina Macs look like half the actual 
number of pixels measured vertically and 
horizontally because of pixel doubling. To 
change resolution (ie, make things look 
bigger, or smaller and more detailed, on 
your screen), you must first check Scaled 
in the Displays pane (circled, above). Then 
see five options. These range from larger 
text to more space, with the Default 
setting in the middle.
If you have aging eyes or just want to see 
less on your display, try one of the settings 
to the left of the Default option. If you 
want to see more on the display — with 
smaller fonts, menus, etc — then try 
one of the settings to the right. When 
you hover over one of these options, the 
Displays pane shows a text saying that 
“Using a scaled resolution may affect 
performance.” This is because your 
graphics card might not be able to keep up 
with a higher resolution (ie when things 
look smaller), or that some of your apps 
may not display correctly.

2/ Do quick sums in Numbers — With just 
a couple of clicks, you can add a formula 
that totals up a series of cells, whether 
your numbers are down a column or across 
a row. To do this, click on the cell where 
you’d like to put the sum, and select the 
Formula button in the toolbar.
Choose “Sum” from that list, and Numbers 
will automatically do just that.
As you can tell, though, you can also use 
this handy toolbar button to do averages, 
products, and more, quick as a wink. And 
if you need advanced options, pick “Create 
Formula” from under that button, and 
you’ll see all of the functions you can use 
(there are a lot!).

3/ Conditional Formatting in Numbers — 
This feature works like rules in Mail: ‘if this 
thing is true, then do this, but if this other 
thing is true instead, do that.’ For example, 
you can set up some conditions on a range 
of cells to say “If the number within you is 
greater than 1000, colour the cell green; if 
it’s less than 500, colour it blue.”
Select the cells you want to apply the 
formatting to, then click “Format” in the 
toolbar to slide your options out if they 
aren’t already visible.
Under those tabs on the right, choose 
the “Cell” one, and there you’ll see 
“Conditional Highlighting.”

Set your parameters for what rules 
you want your cells to follow there. 
Try “greater than, less than”. Use text 
conditions to find cells that start with or 
end with certain words.
Make conditions by date, even, and be sure 
to keep adding on those rules until you’re 
satisfied with the formatting options 
you’ve set. Then you’ll be able to visually 
screen your data faster, and your budget 
will thank you. [MacObserver has more 
info and pictures explaining this.]

4/ Use keyboard shortcuts to add rows 
and columns — Option plus any of the 
arrow keys will add things in for you. Here 
are the choices:
Option–Up Arrow: Adds a row above the 
one you’re on
Option–Down Arrow: Adds a row below 
the one you’re on
Option–Right Arrow: Adds a column to 
the right of the one you’re on
Option–Left Arrow: Adds a column to the 
left of the one you’re on.

5/ OK, for the real power users, how to 
create an animated GIF in Photoshop 
— You’ll need Photoshop (CS6 Extended 
or any version of CC) but this tip is so 
long, you may as well read it online at 
Macworld ...

Some Mac tips, simple to complex
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Ten tips for iOS (iPhone and iPad, and even iPod touch) for the holstips&tricks
1/ Block numbers from texting or calling 
you in iOS — If you’re running iOS 7 or 
later, you can stop those telemarketers 
and repetitive wrong-number diallers with 
this quick and easy trick. To block someone 
already on your contacts list, open the 
Phone app, select a contact card, scroll 
down toward the bottom, and tap Block 
this Caller. If you’re blocking someone in 
your Recents list of the Phone app, tap the 
‘i’ to get their contact card. Aside from 
that, the process is the same.

2/ Take screenshots — Sometimes there’s 
no better way of showing what’s on your 
iPhone than with a screenshot. Press 
both the sleep/wake button (on the top 
of iPhones up to 5, and at top-right of 
iPhones 6 and up) and the Home button 
simultaneously. It might take a little 
practice to get the hang of it, but once 
your iOS device recognizes the screenshot 
command, the screen will briefly flash 
white, as if a camera flash went off.
All screenshots get saved to your device’s 
Camera Roll. To view your screenshot, 
open the Photos app and look through 
your Camera Roll. iOS 9 and later makes 
finding your screen captures easier than 
ever by automatically placing them in a 
Screenshots album. From there, you can 
share and edit screenshots just as you 

would any other image file: crop them, 
share them with your friends, whatever.

3/ iPhone battery is draining faster than 
usual is a typical holiday concern — iOS 
reports the percentage of power use by 
app in Settings>Battery. This feature is a 
nifty way to see if anything has run amok. 
You can toggle between Last 24 Hours 
and Last 7 Days, which helps see if any 
particular app’s usage has spiked. Tapping 
the clock icon toggles between showing 
the way an app uses the battery other than 
in the foreground (Audio and Background 
Activity), and a display of the amount of 
time the app was in use on screen in the 
foreground and handling activities in the 
background.

4/ Make iOS 9’s default apps disappear — 
While Apple is still working on an official 
method of dealing with unwanted default 
apps in iOS, a glitch in iOS 9 through 9.2 
will let people temporarily push them out 
of sight.
As seen in this video, users have to move 
the unwanted apps into a folder, then 
drag them as far to the right as possible, 
beyond any and all of the folder’s tabs. 
With an app still suspended ‘mid-air’, 
hitting the Home button simultaneously 
will cause it to vanish.

Apps hidden this way aren’t permanently 
deleted — instead, they return only once 
an iOS device is rebooted. Simply putting a 
device to sleep leaves them invisible.

5/ Use a hardware shutter for your 
Camera app — You can use the physical 
volume buttons on the side of your 
iPhone to take the shot rather than the 
big onscreen button, which is handy if 
you’re holding 
the phone 
horizontally 
and at an 
awkward 
angle – but 
you can also 
use the Apple 
headphones 
with the remote controls on them (below) 
and even third-party examples that have 
inline volume controls on the cable.

6/ Use the self-timer — There’s a self-
timer on the iPhone as well: a two-second 
one and a 10-second one which is great for 
those press-the-shutter-run-back-into-
shot-then-hold-a-grimace-way-past-the-
point-you-think-it-should-have-triggered 
shots. Tap the little timer icon at the top in 
Camera mode to choose the one you want. 
You might be able to prop your iPhone up 
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tips&tricks Holiday tips to help rein in your iDevice (continued)

against something for these, but consider 
a tripod for more control and better 
results if the shot is important.

7/ Reduce camera shake — push the side 
of your body against a vertical surface to 
steady it, resting your elbows on a low 
wall, or even simply bracing your iPhone by 
holding it in both hands and tucking your 
elbows into your body. But also consider 
the two-second self-timer, since you’re not 
actually pressing a shutter when you’re 
taking a shot, camera shake is reduced: 
enable the timer, press the shutter, then 
in the two seconds before the camera 
actually takes the shot, brace yourself and 
hold the iPhone firmly.

8/ Burst mode — One reason pros are able 
to get such great portrait shots is because 
they can take many dozens or hundreds of 
shots and just pick the one that captures a 
fleeting expression or a moment of delight 
or seriousness. You can do the same with 
your iPhone, and it’s great for getting the 
perfect shot of your kid grinning or your 
dog’s guilty look when you discover him 
tearing up a cushion. Just hold the shutter 
down (whichever shutter you use – the 
virtual one on the camera screen or the 
volume control as above) and let the 
camera just keep shooting.

This uses up loads of space on your device, 
but once you get a quiet moment go to 
that burst of shots in your Camera Roll 
and tap Select, scrub through all the shots, 
tap the ones you like then tap Done; you’ll 
be given the choice of saving everything or 
just the ones you selected, so the rubbish 
shots get deleted.

9/ Specific shooting mode with 3D 
Touch — If you have an iPhone 6s or 6s 
Plus (only), press hard on the icon for the 
Camera app on your Home screen and 
you get the option of jumping straight 
to slo-mo, video, selfie, or regular photo 
mode. (It’s worth reinstating the Camera 
app on your first screen of apps if you’d 
previously banished it since the Control 
Center button for launching it, partly 
for this direct-mode-launch feature but 
also because Touch ID is so fast on the 
6s-generation devices you don’t get the 
chance to see Control Center from the 
Lock screen!)

10/ Go nuts since filters are non-
destructive — You might think filters 
(right) you apply when you’re taking 
photos (the three-overlapping-circles icon 
at the bottom right, shown right) mean 
effects are permanently “baked into” your 
shot, but no. Even though the filter looks 

like it’s applied when you view your photo 
in your Camera Roll, actually what your 
iPhone has done is save the unfiltered 
photo along with an invisible tag that 
says “put the filter in front of this image 
when displaying it.” Tap Edit and you can 
change the filter or remove it completely. 
This goes for the Light, Color, and B&W 
controls you can tweak too.
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tips&tricks
1/ You can turn the scroll bars back on — 
In System Preferences, which is probably in 
the Dock (grey cogwheels) and if it’s not, 
it’s always available from the Apple menu) 
on the General tab, you can turn ‘Show 
scroll bars’ to  ‘Always,’ and your scroll 
bars will always be visible. Then you’ll 
always know if a field is scrollable.

2/ Safari Favorites (sic) — OS X by 
default now hides the favourites bar in 
Safari. To turn them back on, just choose 
View>Show Favorites Bar.

3/ Change the Dock appearance — The 
so-called stacks that appear on the right-
side of the Dock (or at the bottom if you 
have the Dock on the side, as I do, above) 
can be confusing. 
Folders in the Dock (see the final section 
for more on this) show their contents 
rather than a folder icon, which means the 
way they look changes when something 
new is added to the folder it’s linked to 
(this is in the area to the right or bottom, 
between the Trash and the vertical divider 
line, which is the area for files and folders 
rather than apps as in the rest go the 
Dock). To switch this, right- or Control-
click on one of those Dock folder icons on 
the right or bottom, and choose ‘Display 
as…Folder’ from the popout menu.

4/ Add descriptive text to Mail’s 
toolbar — To make Mail’s icons more 
understandable, right- or Control-click on 
Mail’s toolbar (the grey strip across the top 
of the window) and choose ‘Icon and Text’ 
from the menu that’ll appear, and those 
icons will actually mean something.

5/ Bluetooth’s secret Debug menu — If 
you’re having issues with a connected 
peripheral device like a Bluetooth 
keyboard or mouse, there’s a special menu 
option buried beneath the Bluetooth 
symbol near the top-right of your screen. 
(If you’re missing that icon, open System 
Preferences, select the Bluetooth tab and 
check ‘Show Bluetooth in menu bar’.)
Once you can see it at top right of your 
screen, hold down the Shift and the 
Option keys on your keyboard at the same 
time, then click on the icon. A Debug menu 
appears. This contains a few very useful 
choices: Reset the Bluetooth module” 
completely wipes all of the hardware 
module’s settings. Enable Bluetooth 
logging creates a new log file (viewable 
within Applications > Utilities > Console) 
that you can check out if you’re great at 
parsing log-speak.
The fourth option, Remove all devices, 
would be great to know about if you were 
moving, say, a mouse and keyboard to a 

new workstation, as they’d then be easy to 
pair with the new Mac.
The third choice, Factory reset all 
connected Apple devices, forces your 
Apple stuff back to factory settings, which 
is an incredible troubleshooting step if 
you’ve already tried things like turning the 
devices off and on again, unpairing and 
re-pairing, deleting Bluetooth preferences, 
resetting the SMC, and so on. Your Mac 
will give you a somewhat ambiguous (but 
still scary!) warning if you attempt to do 
this:

Extra: there’s one more quick trick. If 
you hold down Shift-Option, click on the 
Bluetooth menu, and then select one of 
your connected devices, you can choose to 
do a factory reset on that device only.
(Be aware that if you choose to do a 
factory reset on anything, you’ll have to 
re-pair it to your Mac, so here are Apple’s 
instructions on how you do so. But 
hopefully, whatever big bad Bluetooth 
problems you were having will be resolved 
after that, and nothing will have to 
get thrown at the wall or set on fire or 
stomped into pieces out of anger! A girl 
can dream.)

(These Bluetooth tips came from the Mac 
Observer site.)

More tips for Mac users – hints and secrets
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Keep your Mac, iPad and iPhone clean to run sweet

Keeping your files and resources under control 

goes a long way to making your Apple experience 

more rewarding 

iDevices (iPad, iPhone, iPod touch)
Move apps — when you first get an iDevice and set it up, once it’s 
all go, you get a message telling you how 
to move apps around and how to make 
folders. Unfortunately, you often ignore the 
message or fail to take note as you want to 
be using your device ... naturally enough. 
So here’s how:
Hold your finger over (don’t press) any 
app icon for a few seconds — this puts the 
iDevice into Edit Mode (some call it ‘jiggle 
mode’). 
Once app icons are jiggling, you can move 
them around.
Move them to a different screen — You 
may need to develop a bit of a nack, but you 
can drag an app from one Home Screen to 
another. Just drag it to the edge and hold 
it there till the screen flips to the next, left 
or right, and then place it where you want. 
Just press the Home button again to go back 
to normal. 
Make folders — In Edit Mode you can also 
make folders. These are containers that can 
hold several apps at a time, saving space 
(I’m a stickler for only having two Home 
Screens on any device – it’s so much easier 

Clean&Tidy
to cope with than multiple screens). Just place an app on top of 
another, and iOS is wise enough to create it for you. 
Empty folders — In Edit Mode, open a folder and drag items out. 
Once it’s empty, the folder simply deletes itself.
Delete apps — In Edit mode, any app with a little X on its top 
corner can be deleted. Just tap it – anything you’ve bought is 
listed as owned by you thanks to background iCloud sync, so 

you can go into the App Store any time and 
re-download it for free (that’s what that little 
cloud icon means next to apps – just tap the 
icon and it downloads again). 
Hide apps — No, you can’t download those 
annoying Apple apps you don’t use. At least 
you can chuck them ina  folder out of the way, 
now. 

Mac
Clear the desktop — Your Finder is an app in 
itself – it controls the interface between you 
and your Mac’s hardware. It’s not designed for 
storage and it’s not very good at it, so when 
things go wrong, anything placed here can go 
awol. Documents are supposed to be in the 
Documents folder, apps in Applications and 
so forth. If your Desktop is littered with stuff, 
putting them away will speed your Mac up and 
everything will be happier. 
It’s well worth the effort – just get used to 
clicking the little Finder icon in the Dock to 
pop a window open that shows fast access to 
Pictures, Applications, Movies and so on. 
Control the Dock — The Dock only holds All my iPhone weather apps neatly in a Weather folder
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Hardware and Software I kept coming back to in 2015Clean&Tidy
things you need a lot. By default, you only have about 15-20 things 
in here while your Applications folder can hold many more (mine 
holds 128 items ...).  
So, my advice is take things out of the Dock if you don’t use 
them. You can delete things from the Dock by clicking on them 
with your mouse or trackpad then dragging them upwards (or 
left or right, as the case may be, if your Dock is on one side, as 
mine is, pictured) 
until you see the 
word ‘Remove’. 
Alternatively, click-
and-hold on them 
and choose ‘Remove 
from Dock’ from the 
Options menu that 
‘pops’.
Now there are a couple of things to be aware of:
1/ Things in the Dock aren’t exactly ‘things’ — Technically, 
they’re ‘aliases’ of real things (apps etc) that are in your 
Applications folder. Dragging an App to the Dock creates an alias, 
or ‘button’ if you like, that leads to, and launches, the actual app. 
Any app you launch from the Applications folder will appear 
in the Dock, but will disappear again when you Quit the app ... 
unless you click on that icon and choose Keep in Dock from the 
pop-out menu, which means the icon stays there for instant 
access should you wish. 
Therefore — Removing things from the Dock does not delete the 
actual app – that’s still safe in your Applications folder. 
But do add things into the Dock that you do use a lot.
Rearrange —  You can drag things left-and-right, or up-and-down, 
to rearrange the sequence they appear in. 
Make launch folders — I have lots of things in my Dock as I use 

lots of things a lot. If you’re an incorrigible app user like me, 
make folders of Aliases and put those in the Dock, since the area 
between the divider (a very slim line) and the Trash is not for 
apps, but for files and folders. Here’s how:
Open your Applications folder. You may need to click the Finder 
icon in your Dock, then click Applications in the left (the Sidebar) 
of the window. Now choose File>New Folder (or hold down the 

Command key, and while it’s held down, press the Shift and N 
keys at the same time). 
Call it something useful – I have iWork, iLife and Notes. To 
rename a folder, click it once, press Enter (or the Return key), 
type your name, press Enter again.
Now choose the apps you want in here. Select an app with 
a single-, not a double- click (a single click selects an item 
whereas a  double-click launches it – note that you don’t need 

to double-click things in the Dock as they’re buttons, not things). 
Once you have an app selected, 
go to the File menu and choose 
Make Alias (or Command-L). 
This makes a little ‘button’ of the 
originating item, marked by an 
curved arrow on the left. 
Drag these aliases into your 
folders. In the iWork folder I 
have aliases for Logic, Final Cut, 
Numbers, Pages and Keynote. In 
iLife I have iMovie, Garageband, 
Maps, Messages, iBooks and 
so on. Now drag the folders you made into the area in the Dock 
between the divider and the trash, and you can launch several 
apps from one icon, saving precious space: click the folder, choose 
the app you want to launch and voila. 
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Special glasses aim to make your computerised work less tiringShiny&New
OPSM Anti-Fatigue eyeglass lenses
These are lenses optimised to relieve visual fatigue symptoms 
from long hours of computer use, for example headaches, eye 
strain and blurred vision.
The lenses use several features 
to achieve this: a slight power 
variation of +0.6D to relieve eye 
strain and provide more comfort 
from sustained looking at a fixed 
distance, and optimised digital 
surfacing to help give clear and 
accurate vision on every point of 
the lens. This means the eye can 
move and read effortlessly from 
the screen to the keyboard to the 
desk
There’s also a blue light lens 
coating called Crizal Prevencia. 
This anti-reflective coating can help reduce digital eye-strain, 
and you can see this as a purple cast but not if you’re wearing 
the glasses; wearing them, the affect is so subtle as to be barely 
noticeable, although colour-critical applications may not be 
optimal. 
Unlike traditional progressive lenses, these are designed 
specifically for computer users in office environments to offer a 
larger computer vision zone, allowing the user to comfortably 
work for extended periods of time. This can be combined with a 
far vision element to assist with all round office use where the 
user is not only requiring lenses at their desk. 

Tests
OPSM runs a full and very comprehensive eye check before 

discussing whether these would suit you, or whether the 
‘Extended Focus Reader’ might be better for your situation. 
I found this eye check (in my case at OPSM Remuera) both 
informative and detailed. The Extended Focus Reader also has 

the optimised digital 
surfacing but the fields 
of vision are wider 
and offer natural head 
posture for a better 
visual and physical 
comfort on screen 
than a standard 
progressive; the zones 
and distances are also 
worked out during 
your eye check. 

In use
I find it a bit of a mind-shift when I first put these glasses on, 
as I’m very used to the progressive lenses of the glasses I have 
from my usual optician, Harrison and Graham at Three Lamps, 
Ponsonby. These also allow me to see clearly in the distance, 
whereas the Extended Focus Readers OPSM recommended for 
me don’t have the distance function. But within a minute or two I 
get completely used to the Crizal Prevencia-coated lenses and for 
extended sessions in front of my two-screen Mac setup with my 
iPad and iPhone at hand, I find these both comfortable and crisp, 
and definitely not tiring.
The lenses can be fitted to a variety of frames to suit your taste. 
I also find them better for viewing things that need a slight 
magnification – even the tiny grey script on some Apple devices. 
More information: OPSM branches around New Zealand.
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